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Preface 

Purpose 

This document describes how to install the Oracle Gateway Device Handler (OGDH) and 

the Oracle Payment Interface (OPI). 

 Installing the OGDH  

 Installing the Oracle Payment Interface  

 Configuring the POS for the OPI using the OGDH Introduction to the product. 

Audience 

This document is intended for installers of OPI and OGDH. 

Customer Support 

To contact Oracle Customer Support, access My Oracle Support at the following URL: 

https://support.oracle.com 

When contacting Customer Support, please provide the following: 

 Product version and program/module name 

 Functional and technical description of the problem (include business impact) 

 Detailed step-by-step instructions to re-create 

 Exact error message received and any associated log files 

 Screenshots of each step you take 

Documentation 

Product documentation is available on the Oracle Help Center at 

http://docs.oracle.com/en/industries/hospitality/ 

Revision History 

Date Description of Change 

February 2019 Initial publication. 

March 2019  Updated formatting and cover page with new 
template. 

 Updated details for tender mapping in Chapter 4 
Installing the OGDH Driver. 

 Added Chapter 7 Not Supported Functionality. 

July 2019 Updated security bugs in few chapters. 

https://support.oracle.com/
http://docs.oracle.com/en/industries/hospitality/
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Pre-Installation Steps 

Before Installing the OPI 

IF UPGRADING OPI, YOU MUST READ THE UPGRADING THE OPI SECTION FIRST. 

Complete the following tasks before installing: 

 The OPI application requires Microsoft .NET Framework version 4.0 or higher.   

 You must uninstall previous versions of MPG before installing OPI 19.1 

 You cannot upgrade from previous versions of MPG to OPI 19.1  

 You can upgrade from OPI 6.1 and higher to OPI 19.1 

 You can upgrade from MGDH 6.1.1 and higher to OGDH 19.1 

 Verify with the merchant to setup table service (TSR) or quick service (QSR), or both.  

QSR does not support tips. 

 Verify with the merchant if activating the Refund functionality, the merchant must 

control the privilege for this function.  

 Verify with the merchant if they offer a guest the option to get cash back with their 

purchase, then activate the Sale & Cash option. This is only available for QSR.  

 Confirm Microsoft Visual C++ 2010 is installed on the computer where OGDH and 

OPI are installed. 

 It is required to use JRE 8U131 or above build of JRE8 for OGDH machine if you do 

OGDH installation without connecting to POS database 

 Confirm Java Platform, Standard Edition Runtime Environment (JRE) version 1.8.152 

or higher but below 1.9 is installed on the computer where OGDH and OPI are 

installed.  

 Transactions from previous OPI versions will not settle or Void once system is 

upgraded to OPI 19.1. All transactions must be settled/finalized before upgrading. 

 Oracle Payment Interface requires at least 6 GB of free disk space.  

 You must install both OGDH and OPI as a System Administrator. 

 OPI 19.1 does not install a database.  If doing a clean install of OPI, a database must 

be installed first.   

During the installation you must confirm the following: 

 Merchant IDs  

 Receipt “Header” and “Trailer” details 

 Tender Media numbers for each card type 
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 IP address of the OPI Server  

 If there is an existing MySQL database installed, then the SQL root password is 

required. 

 Workstation IDs and IPs that integrate with the PIN pad. 
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Network Considerations 

You must consider the following points for the network: 

 OPI listens on the TCP port 5098 for incoming messages from OGDH, this port must 

be open internally on the merchant’s network. 

 The port for the PIN pad depends the partner, confirm with the partner and confirm 

the corresponding port is open. 
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9700 Server Configuration 

Adding an Interface 

To configure the 9700 Server you must add a new interface.  

1. In the Enterprise Management Console, go to the Interface tab. 

2. Define the following Interface values. 

Table 3-1 - Insert Interfaces 

Interface Value 

System Name OGDH 

Service Type PMS/SIM 

Communication Type TCP/IP 

Timeout 210 

ISL Script Name pms7 

 

3. Select the check box to enable the option to Use 19 Digit Reference Entry for PMS 

Inquiries. 
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Figure 3-1 - EMC Interfaces tab 

 

 

Configuring RVC 

To configure the RVC, link the interface OGDH to each RVC. 

1. Go to the Enterprise Management Console. 

2. Go to the RVC Parameters tab and link the OGDH interface to each RVC. 
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Figure 3-2 - EMC RVC Parameters 

 

If the RVC is configured in QSR mode, then activate the options below: 

 Select the check box Do Not Prompt for Tips (No Overtendering if Charge Tip is 

Required).  

 Select Allow Fast Transactions. 
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Figure 3-3 - EMC RVC Parameters General Options 

 

If using the TSR mode, do not activate this option. On the Format tab, configure and 

enable the following options for the TSR RVCs: 

1. Define the Number of Guest Check Information Lines as 30. 

2. Select the check box Skip Blank Lines When Print or Display Guest Check Info 

Lines. 
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Figure 3-4 - EMC RVC Parameters Format Options 

 

 

Employee Configuration 

1. Go to the Employee Maintenance tab, select the Cashier employee class. 

2. Select the check box to activate the ISL Employee Option #4 option to define the 

employee class that can process a refund. 
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Figure 3-5 - EMC Employee Maintenance – Employee Classes 

 

3. Enable the Authorize/Perform Closing of Checks with a Negative Balance 

Tenders option. 
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Figure 3-6 - EMC Employee Maintenance Tender Options 

 

Service Charges 

If the merchant provides a Cash Back option, then add a new Service Charge for the 

CashBack option. This is the same as the Open Amount Service Charge. You can skip 

this step if the merchant does not activate the SalesCash function. 
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If the merchant provides a Gift Card Cashout option, then add a new Service Charge for 

the Gift Card Cashout option. Using the settings below, you can skip this step if the 

merchant does not activate the Gift Card Cashout function. 
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Configuring Tender Media Records 

Configure the following options for the credit/debit card tenders. 

1. In the Enterprise Management Console, go to the Tender Media tab. 

2. Select the Options tab and select the category Interface Options.  

3. Activate the PMS and Credit Card use 19 Digit Acct Number option. 

Figure 3-7 - EMC Media Tender Options 

 

 

To configure the credit card options: 

1. Go to Options tab select Credit Card Options. 

2. Deactivate all options and remove the floor limit/preambles list. 

3. Enable the No Credit Card Length Check option. 

To configure the POS options: 

1. Go to the Options tab and select POS Behavior, to active the following options: 

 Assume Paid in Full 

 Reference Entry Required 

2. Deactivate the following options: 

 Mask Account Number 
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 Encrypt Tender/Media Reference Entry 

3. Link the tender to Open amount Service Charge for TSR environments. 

4. Add the debit tender option the same way you would for normal credit card tenders. 

5. Add the new tender Gift Card option the same way as a normal credit card tender. 

You can skip this step if the merchant does not activate the Gift Card function. 

6. Add the new tender SaleCash option the same way as a normal credit card tender. 

You can skip this step if the merchant does not activate the SaleCash function. 

 
  NOTE: 

The SaleCash tender is only supported when utilized in a Quick Service 
Restaurant (QSR) environment. 

 

Figure 3-8 - EMC Tender Media POS Behavior Options 

 

Touch Screen Design 

First, contact the Oracle Hospitality Consulting Team for confirmation, and then if 

required, add the following buttons to the payment screen. The key types are Functions 

and you can link them to the OGDH interface. 
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Table 3-2 - Table Service Restaurant (TSR) Payment Screen 

Field Value 

CC PAY SIM INQ #2 

CC REFUND SIM INQ #4 

CC AUTH SIM INQ #8 

CC FINAL SIM INQ #9 

TAB AUTH SIM INQ #12 

BALANCE INQUIRY SIM INQ #14 

CC REPRINT SIM INQ #7 

CC REPOST SIM INQ #16 

MANUAL AUTH SIM INQ #15 

REFUND MANUAL SIM INQ #11 

GC Function SIM INQ #10 

AUTH CNP SIM INQ #20 

 

Table 3-3 - Quick Service Restaurant (QSR) Payment Screen 

Field Value 

QSR SALE SIM INQ #1 

SALE CASH SIM INQ #5 

CC REFUND SIM INQ #4 

BALANCE INQUIRY SIM INQ #14 

CC REPRINT SIM INQ #7 

CC REPOST SIM INQ #16 

REFUND MANUAL SIM INQ #11 

SALE CNP SIM INQ #6 

GC Function SIM INQ #10 

 

OPI shares the VOID touchscreen key with the 9700 POS. Using the VOID key you can: 

 Void the transaction 

 Add Tips (for TSR only) 
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Menu Item Configuration 

The two open menu items that need to be created are Gift Card activate transaction and 

Gift Card reload transaction. 

The menu item class -- "GC Open Item" 

Setup the following for the menu item class. 

 Menu Item class name   - "GC Open Item" 

 Reference required 

 Open-priced Menu Items 
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Menu item -- "GC Activate" 

Setup the menu item master--"GC Activate". 

 

Define menu item. 

 Menu Item class name   - "GC Open Item" 

 Menu Item Master name   - "GC Activate" 
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The Menu Item -- "GC Topup" 

It is defined as same as "GC Activate". 

Set up the menu item master--"GC Topup". 

Define menu item. 

 Menu Item class name   - "GC Open Item" 

 Menu Item Master name   - "GC Topup" 
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Installing the OGDH Driver 

Installing OGDH on the 9700 Server 

1. In Microsoft Windows, log in as an administrator, and then run the 

OGDH_OPI_19.1.0.0.exe file. 

2. Click Next. 

3. A Welcome screen displays. Click Next. 

4. A Checking dependencies screen displays. Click Next. 

 

5. Select the install location, and then click Next. 

6. On the Ready to Install the OGDH screen, click Install. 

7. On the Connect to 9700 database screen, click Connect or Skip DB Connection. 

If you connect to 9700 database, you must select the DB type, enter the Host or IP 

address, Port, DB name/SID, and Username and Password. 
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8. Select a currency, and then click Next. 

 

9. On the Configuration details for property screen, set the Device Merchant ID, Mode, 

Receipt Header/Trailer for each Revenue center. 
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 For the header, do not exceed 6 lines. For each line, do not exceed 33 letters or 

special characters. 

 For the trailer, do not exceed 12 lines. For each line, do not exceed 33 letters or 

special characters. 

10. On the Tender mapping configuration screen, link the correct tender number for each 

tender. Leave unused tenders blank. 
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11. On the Extra Tender mapping configuration screen, if you need use extra tenders, 

select the Enable extra tenders option, and link the correct tender number for each 

tender. Leave unused tenders blank. 

 

12. On the Transaction configuration details screen, select the options required for the 

merchant, and then click Next. 
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Adjust Tip: Enable if the ability to adjust tip amount is needed. 

Adjust Tip 2: Enable if you need to adjust tips with a transaction that already has a tip. 

Allow Tab Auth: Enable if initial authorizations are allowed. 

Gift Card Support: Enable if gift cards will be sold. 

Use GC denominated value: Enable if gift cards are sold in pre-determined amounts. 

If disabled, the POS asks the cashier to input the amount for the gift card activation. 

Local Printer: Enable Local Printer 

List Local Printer: List Local Printer 

Print Failed Receipt: Enable if vouchers should print when a card is declined. 

13. On the Configuration details screen, enter all required values. 
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Host / IP Address: Enter IP address of the OPI server PC. 

Port: Port used to communicate to OPI. 

Tab Auth Amount: Initial authorizations will default to this preset amount. 

Receipt Limit Amount: Enter the amount, below which vouchers should not print. 

GC activation menu item: Enter the GC activation menu item. 

GC top-up menu item: Enter GC top-up menu item. 

POSEOD Device Merchant Id: Make sure there are no duplicate MIDs, and then click 

Next. 

14. Click Save on the OPI Service Configuration screen. 
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Point-of-Sale (POS) End-of-Day (EOD) 

You can use the Microsoft Windows Task Scheduler to run the OPI POSEOD using the 

following configuration details. 

Table 4-1 - Microsoft Windows Task Scheduler Settings 

Temporary Table 

Name OPI POSEOD 

Description Generates the OPI transaction report 

Trigger Daily 

Action Start a program 

Program/script Browse to find the POSEOD.exe in 
OGDHDriver directory 

Add arguments (optional) The upper level of the POSEOD.exe path 

Start in (optional) The upper level of the POSEOD.exe path 

 

For more information on how to setup the Microsoft Windows Task scheduler visit the 

Microsoft website at: http://www.microsoft.com 

http://www.microsoft.com/
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Installing the OPI 

1. Copy OraclePaymentInterfaceInstaller_19.1.0.0.exe to the Server and 

double-click it to launch the install. 

2. Select a language, and then click OK. 

3. Click Next on the Welcome to the InstallShield Wizard for Oracle Payment Interface 

screen. 

4. Click Next on the OPI Prerequisites screen appears. 

 

The Setup Type screen appears. 

 Complete: All program features will be installed. 

 Custom: Select which program features you want installed. Recommended for 

advanced users only. 

5. Make a selection, and then click Next. 
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If you selected the Custom install option, the Select Features screen appears with the 

following options: 

a. Database Schema 

b. OPI Services 

c. Configuration Tool 

All three of these features must be installed.  It is just a matter of whether they are all 

installed on the same computer or on separate computers. 

6. Select the features to install on this computer, and then click Next. 

The Choose Destination Location screen appears. 

7. Accept the default installation location or click Change… to choose a different 

location, and then click Next. 

8. Click Install on the Ready to Install the Program screen. 

The Setup Status screen displays for a few minutes. 

9. The Setup Type screen appears.   
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10. Select the database type being used, and then click Next. 

 
  NOTE: 

OPI does not install any database, so the database must already be installed. 
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The Database Server screen appears. 

11. The Name/IP: field defaults to localhost. This should be left as localhost if the OPI 

database is installed on the same computer. If the database is installed on another 

computer, the Name or IP address of that machine should be entered here. 

 
  NOTE: 

If the database type is MySQL, and you cannot use localhost for the Name/IP 
field, then some commands must be run manually on that MySQL database 
before proceeding. See MySQL Grant Permission in the OPI Installation and 
Reference Guide for instructions. Setup will not complete if this is not done. 

 

12. Accept the default Port # of 3306 (for MySQL), and then click Next. 

The Database Server Login screen appears. 

 

13. Enter the credentials for the DBA user of the database type selected, and then click 

Next. 

 For MySQL the Login ID: = root 

 For other database types the DBA user name/Login ID may be different. 

 Enter the correct password for the DBA user. 

The Database User Credentials screen appears. 
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14. User Name: Create a new user.   

15. Password: Create a password. Password is case sensitive, should be at least 8 

characters in length and must have at least one upper case letter, one lower case 

letter, one number and one special character from the following list:!@#$%^&*. 

16. Confirm the password, and then click Next. 

17. Click OK on the Database connection successful dialog.  

18. Click OK on the Database Configuration operation successful dialog.  

The Configuration Tool Superuser Credentials screen appears. 
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19. User Name: This can be any user name. It does not have to be a Windows account 

user. 

20. Password: Create a password. Password is case sensitive, should be at least 8 

characters in length and must have at least one upper case letter, one lower case 

letter, one number and one special character from the following list:!@#$%^&* 

21. Confirm the password, and then click Next. 

22. Click OK on the Create SuperUser operation successful dialog. 

The Configuration Tool Connection Settings screen appears. 
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 Host: Enter the IP address or server name of the PC where the OPI Config Service is 

installed. This will be the PC where you selected “OPI Services” to be installed.   

 Leave the default Port of 8090. 

23. Click Next. 

The Configuration Tool Passphrase screen appears. 
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24. Passphrase: The passphrase is case sensitive, should be at least 15 characters in 

length and must have at least one upper case letter, one lower case letter, one 

number and one special character from the following list:  !@#$%^&* 

25. Enter a passphrase, confirm it, and then click Next. 

After a brief pause, the Configuration Wizard launches. 

26. Select POS, select OGDH, and then click Next. 

 

27. Enter and confirm the passphrase, and then click Next. 

 

The OPI Interfaces screen appears. 

28. Configure settings as required. 
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29. Enable Mutual Authentication: Enable this option only if the PSP has provided the 

certificates and passwords for it.   

30. Private Key Cert. Password: Enter the password and confirm it. 

31. Root Certificate Password: Enter the password and confirm it. 

- OPI Mode: Select either Middleware or Terminal. 

- Middleware: Fill in primary host connection information and the failover Host 

information (if provided). 

- Terminal: Select correct Port. 

- If using Mutual Authentication, see the Mutual Authentication section in the 

Oracle Payment Interface Installation Reference Guide. 

 

32. Add merchant, and then complete the required merchant information fields. 
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33. Complete the following Merchant Terminal Configuration fields: 

 Workstation ID: Enter the workstation number from the POS system. 

 Terminal IP: Enter the IP address of the pinpad device 

34. Click Next. The POS Merchants screen appears. 

35. Click Close to advance to final screen. 

 

36. Click Finish to reboot.  

If you cannot immediately reboot, you must stop and then start the OPI Service for 

current settings to take effect. 
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Upgrading the OPI and OGDH 

VERY IMPORTANT:  Read and follow the upgrade directions. 

 
  NOTE: 

OPI 6.1 and higher can be upgraded to OPI 19.1. OGDH 6.1.1 and higher can 
be upgraded to OGDH 19.1. 

 

OPI 6.1 to 19.1.0.0 Upgrade Steps 

1. Right-click and Run as Administrator the 

OraclePaymentInterfaceInstaller_19.1.0.0.exe file to perform an 

upgrade. 

2. Select a language from the drop-down list, and then click OK. 

3. Click Next on the Welcome screen to proceed with the installation.  

Prerequisites for the installation will be checked, including the required free drive 

space, details of the host environment, and the Java version that is present. 

4. Click Next on the OPI Prerequisites screen. 

 

5. Click OK on the OPI Upgrade screen. 
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6. WARNING! You must click Yes. 

IF YOU CLICK NO, YOU WILL HAVE BOTH OPI 6.1 AND OPI 19.1 INSTALLED 

AND NEITHER WILL WORK. 

Explanation: OPI will migrate the existing MySQL configuration information, but all 

previous OPI applications will be removed before the new files are installed. 

7. Choose a Destination Location. Accept the default installation location or click 

Change… to choose a different location and Click Next. 

8. The Ready to Install the Program screen displays and Click Install. 

The Setup Status screen displays for a few minutes. 

Setup Type 

For database type, select MySQL. No other database type is supported for upgrades. 

Database Server 

Name/IP: The Hostname or IP Address used for communication to the MySQL 

database. This must be left at the default of localhost. 

Port #: The Port number used for communication to the database  

Database Server Login 

DBA user 

Login ID: root 

Password: root user password for MySQL database. 

Database User Credentials 

User Name: This must be a new user name.  It cannot be the same user from the 6.1 

install. 

Password: Password for the new database user. 

Configuration Tool Superuser Credentials 

User Name: This can be any user name. It does not have to be a Windows account 

user. 

Password: Create a password, and then confirm it.  

Configuration Tool Connection Settings 

Host: Enter the IP address or server name of the PC where the OPI Config Service is 

installed. This will be the PC where you selected “OPI Services” to be installed.   

Port: Leave at 8090. 
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Configuration Tool Passphrase 

Enter and confirm a passphrase. 

Click Next. 

The Configuration Wizard launches. 

Continue to follow on-screen directions, verifying settings as you go. 

POS Merchants 

On the Merchants screen, click the wrench icon to the right of the existing merchant. 

Verify the merchant settings are correct. 

InstallShield Wizard Complete 

Click Finish to allow a reboot. 

If you cannot immediately reboot, you must stop and then start the OPI Service for 

the current settings to take effect. 

OPI 6.2 to 19.1.0.0 Upgrade Steps 

1. Right-click and Run as Administrator the 

OraclePaymentInterfaceInstaller_19.1.0.0.exe file to perform an 

upgrade. 

2. Select a language from the drop-down list, and then click OK. 

3. Click Next on the Welcome screen to proceed with the installation. 

 

4. Click Next on the OPI Prerequisites screen. 
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5. Choose a Destination Location. Accept the default installation location or click 

Change… to choose a different location and click Next. 

6. Click Install. When The Ready to Install the Program screen displays. 

7. Click OK when The Database upgrade operation was successful screen displays. 

8. Enter the configuration Server connection information. 

 

9. Click Finish to restart your computer. 
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OGDH 6.1.1 to 19.1.0.0 Upgrade Steps 

1. Right-click and Run as Administrator the OGDH_OPI_19.1.0.0.exe file to perform 

an upgrade. 

2. Click Next on the Welcome screen to proceed with the installation.  

3. Click Next on the Upgrade files screen. 

 

4. Choose a Destination Location. Accept the default installation location or click 

Change… to choose a different location. 

5. Click Install to install OGDH. 

6. Click YES to remove MGDH. 
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7. On the Connect to 9700 database screen, click Connect or Skip DB Connection. 

If you connect to 9700 database you must select the DB type, enter the Host or IP 

address, Port, DB name/SID, Username and Password 

 
  NOTE: 

If you are not using default pms7.isl as your ISL file, please go to OGDH 
installation location and rename the pms7.isl which under 9700_ExtApp_files 
to the correct number, below is the example location 

C:\OGDH\9700_ExtApp_files 

 

8. On the Tender mapping configuration screen, link the correct tender number for each 

tender. Leave unused tenders blank. 
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9. On the Extra Tender mapping configuration screen, if you need use extra tenders, 

select the Enable extra tenders option, and link the correct tender number for each 

tender. Leave unused tenders blank. 

 

10. On the Transaction configuration details screen, select the options required for the 

merchant, and then click Next. 
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11. Click Finish. 

 

OGDH 6.2 to 19.1.0.0 Upgrade Steps 

1. Right-click and Run as Administrator the OGDH_OPI_19.1.0.0.exe file to perform 

an upgrade. 

2. Click Next on the Welcome screen to proceed with the installation.  

3. Click Finish. 
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  NOTE: 

If you are not using default pms7.isl as your ISL file, please go to OGDH 
installation location and rename the pms7.isl which under 9700_ExtApp_files 
to the correct number, below is the example location which for your reference 

C:\OGDH\9700_ExtApp_files 

Then you need to copy the correct ISL file to POS server root folder, below is 
the example location which for your reference  

C:\Micros\\Les\Pos\9700\etc 
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Not Supported Functionality 

Not supported with RES Native OPI solution: 

 Gift Cards (SVC works as usual thru workstation. Not thru OPI or PED.) 

 Balance Inquiry 

 Void a refund (RES limitation) 

 Debit (RES Native OPI) 

 SaleCashBack (RES Native OPI) 

 Backup OPI Server 

 

Not supported with RES OGDH: 

 Incremental Auth 

 Void a Refund (RES limitation) 

 CC voice / Manual entry in QSR revenue center 

 Backup OPI Server 

 Voiding the tender from a SaleCashBack transaction. 

 

Not supported in the e7 Native OPI driver solution: 

 Gift Cards 

 Balance Inquiry 

 Void a refund (e7) 

 Debit (e7) 

 SaleCashBack (e7) 

 Multiple Revenue Centers (e7) 

 Memo Tender (e7) 

 CC Voice/Manual CC for QSR (offline sale) 

 Backup OPI Server 

 Backup server mode (e7) 

 Pay@Table 

 Transaction Void (e7) 


